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Intro 
 
ComMIT is an interface around NOAA’s Method Of Splitting Tsunamis (MOST) 
tsunami model.  ComMIT is designed for ease of use, and allows the  
dissemination of results to the community while addressing concerns associated 
with proprietary issues of bathymetry and topography. It uses initial conditions 
from a pre-computed propagation database, has an easy-to-interpret graphical 
interface, and requires only portable hardware. ComMIT was initially developed 
for Indian Ocean countries with support from the United Nations Educational, 
Scientific, and Cultural Organization (UNESCO), the United States Agency for 
International Development (USAID), and the National Oceanic and Atmospheric 
Administration (NOAA). 
 
As of 2015, more than 325 scientists from 57 countries around the world have 
been trained and are using it in operational inundation mapping. 
 

Installation 
 

For PC 
 
Put the ComMIT_<ver>.exe file wherever you'd like (the Desktop is fine).  
Double-clicking the ComMIT_<ver>.exe will launch ComMIT. 
 

For Mac 
 
Download the ComMIT_<ver>.dmg file and double-click to launch the ComMIT 
installer. It may complain that ComMIT is an unsigned app: in this case go to 
System Preferences, open Security and Privacy and Allow apps downloaded 
from Anywhere.  Drag the ComMIT app to the /Applications folder.  Close the 
installer.  Double-click ComMIT from the Applications folder. 
 

For linux 
 
Put the ComMIT_<ver>.jar file wherever is convenient (the Desktop is fine).  
Double-clicking the ComMIT.jar will launch ComMIT.  The user can see debug 
info by running on the command-line with “java –jar ComMIT_<ver>.jar –d”. 
 

Installation basics 
 
ComMIT requires Java, and will tell you which version it needs.  If you need to 
upgrade your Java Installation, go to http://www.java.com.   



 3 

 
A folder named "ComMIT" will be created in your home folder.  This directory will 
contain all the files ComMIT installs.  The first time it loads takes a minute 
downloading test grids into this folder.  If you wish to move this folder, ComMIT 
will ask you to locate it the next time ComMIT is run. 
 
The ComMIT->Preferences lets you choose where you work, where your grids 
are, where your source files are, and where your MOST executable is. 
 
If you don't have a MOST executable, you will be asked if you'd like to download 
one.  ComMIT will attempt to choose the proper executable for your platform.  An 
Internet connection is required. 
 

Quick Test 
 
As a quick test of the system, click the Menu “Model->Open Model Run”, and 
choose “Crescent”.  The map on the “Model Setup” tab should show “crescent A-
Grid” in green, outlining Crescent City, California.  Click any white rectangle 
“source” on this map – it should turn red.  Click “Start Model” at the top.  That’s it! 
 
You should see the Model output log indicate the source is downloading, and the 
red rectangle eventually turn green.  You can see an initial condition file created, 
and see it in the Initial Condition tab.  The progress bar at the top of ComMIT 
should start to indicate that the model is running, and time steps should update. 
The model results can be animated as the model runs by clicking the “Results 
Animation” tab. 
 
A more thorough discussion of the Community Model Interface follows. 
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The ComMIT Interface 
 
Tsunami models (both deep-water propagation and inundation) require 
information on: (1) bottom topography; (2) initial and boundary conditions; and, 
(3) model run specific information such as time-step and length of model run.  
The aim of ComMIT is to provide an interface which allows for the selection of 
model input data (initial condition, bathymetry grids, etc.) as well as a platform to 
display model output through a graphical user interface.  ComMIT has been 
written in the Java programming language (http://www.java.com) and uses the 
netCDF file format for model input and output thus making ComMIT platform-
independent (i.e. it may be run on different platforms such as WINDOWS, Mac or 
UNIX).  ComMIT may be used with any computational model with the only 
requirement that the models are able to input and output data in the specified 
format (netCDF). 
 
The interface consists of a “Start Model” button, Progress Bar, and Model Run 
selector at the top, and 5 tabs: “Model Setup”, “Initial Condition”, “Grid 
Bathymetry”, “Results Animation”, and “Results Extrema” (Figure 1). 
 

 
Figure 1: ComMIT Interface 
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Model Setup tab 
 
The first tab, “Model Setup”, shows the location of the Model Run that is currently 
open (“crescent” in this case).  The Model Run consists of three nested grids: an 
outer, low resolution A-grid (in green), a middle, medium resolution B-grid (in 
yellow) and an inner, high-resolution C-grid (in red).  The Model Run consists of 
these three bathymetry files, and a file containing the Model Parameters, all in a 
folder that can be opened by clicking on the button with the Model Run name just 
above the map. 
 

Unit Source Map 
 
The map also shows white rectangles defining a seismic fault plane.  These fault 
planes, know as Unit Sources, can be used to force the Model Run.  The user 
can select one or more of these Sources, and set their “weight” by adjusting the 
Alpha coefficient in the table to the right of the map(Figure 2): 
 

 
Figure 2: Four Unit Sources selected, each with an Alpha coefficient of 1.0, total moment magnitude 
Mw=7.9 

The total moment magnitude (Mw) can be adjusted by changing the Alpha 
coefficient, by adding more Unit Sources, or by editing the magnitude directly. 
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The user can pan the map by clicking and dragging the map, and can zoom by 
mouse wheel or using the +/- buttons.  The drop-down list under the table can be 
used to jump directly to a region on the map and is helpful to jump between 
distance sources (“to Selected”) and back to the Model Run location (“to Site”).  
The Add/Del button opens a dialog that allows selecting Unit Sources by their 
name.  Unit Source names include a two-letter code defining their subduction 
zone (e.g. “ac” for Aleutian-Cascadia subduction zone), and a letter indicating 
their position on- or off-shore, and a number indicating their position along the 
fault.  The “ki1a” fault plane is the first fault plane at along the Kamchatkai-Yap 
subduction zone. 
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Set Model Run Parameters 
 
The MOST model parameters for the run are set manually in the upper-right 
frame of the Model Setup tab (Figure 3).  The following is brief description of the 
model parameters. Details are in the MOST manual. 
 

 
Figure 3: MOST Model parameters 

 
Minimum amplitude of input offshore wave (m) – smaller values of input 
amplitudes are ignored. Input through grid A boundary starts only when absolute 
amplitudes exceed this threshold. This is usually a small number well above 
machine zero (0.001 is typical value) 
 
Minimum depth of offshore (m) – specifies depth for grid A and B where 
reflection boundary conditions will be performed. Typical values are 5 – 10 m. 
 
Dry land depth of inundation (m) – specifies the minimum depth of the water 
column that model performs computations on. If the water level is lower than this 
value, the cell is considered dry and no computation is performed. This 
effectively sets a moving boundary condition threshold. Typical values are 0.1-
0.3 m. 
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Friction coefficient (n**2) – specifies Manning friction coefficient (n2) 
 
Let A-grid and B-grid runup – if checked, the runup computation is performed 
for grid A and B (with the dry land parameter specified in Minimum depth of 
offshore). Otherwise, fixed reflective boundary is set at the same depth. Default 
is “checked”. 
 
Max eta before blow-up (m) – computation is terminated if computed amplitude 
is exceeded this value. 30-100m is recommended. 
Time step (sec) – specifies time step for grid C computation. Grid C is computed 
every time step. 
 
Total number of time steps in run – number of time steps 
 
Time steps between A-grid computations – A-grid wave dynamics may be 
computed less frequently than the C-grid. Since A-grid is coarser than C, the CFL 
condition may be less demanding and a larger time step can be used for stable 
computations. Number of skipped steps multiplied by the time step defines the 
effective time step for A-grid. 
 
Time steps between B-grid computations – same as above for B-grid 
 
Time steps between output steps – specifies the frequency of amplitude and 
velocity field saves 
 
Time steps before saving first output step – output can saved from specified 
time step to avoid saving time steps with zero amplitudes 
 
Save output every n-th grid point – specifies the size of saved files by sub-
sampling the output fields. The parameter is the same for all grids  
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Initial Condition tab 
 
After loading a Model Run, and selecting Unit Sources to force the model, the 
user can initiate a run by pressing the “Start model” button.  The selected Unit 
Sources are downloaded from the ComMITServer and combined according to 
the Alpha coefficients selected in the Unit Source table.  This combination of 
sources can be viewed in the Initial Condition tab, which shows the maximum 
wave amplitude and arrival time (in hours) for the source selected: 
 
 

 
 
 

The color represents the time-maximum wave amplitude, and shows how the 
energy of the tsunami tends to move away from the subduction zone in “fingers” 
or “lobes” extending perpendicular to the coastline. 
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Grid Bathymetry tab 
 
The Grid Bathymetry tab shows a color contour plot of the grid bathy, along with 
an outline of the telescoping grids with the same color code for the grids: green 
for A-grid, yellow for B-grid, and red for C-grid: 
 

 
 
The bathymetry grid file name is displayed just beneath the title of the grid.  
Opening the Model Run folder (from the Model Setup tab) will display this file.  
The user can zoom this image, and select among the three grids using the “Grid:” 
buttons. 
 
 
 
 
 
 
 
 
 

Results Animation tab 
 
The Results Animation tab shows the full time-dependent results for the model 
output, including wave amplitude, velocity and time series (Figure 4).  The results 
of any of the grids can be viewed by selecting with grid with the Grid: A-B-C 
button selector on the left.  The main panel shows a color contour plot of Wave 
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Amplitude over dashed contours of bottom bathymetry, and topography in 
shades of tan and brown.  The tab is split vertically, and the lower window 
contains a time series.  The time series location is shown on the upper Wave 
Amplitude plot by a green star, and the user can change its location by double-
clicking on the Wave Amplitude plot.  The latitude and longitude of the time 
series location star is shown at the top, and editing these values is another way 
of moving the time series location.  The results can be animated by using the 
arrow buttons:   The center button is “Play”, the button just to the 
left and right step one time step back and forward, respectively.  To jump all the 
way to the beginning of the model run, click the double-left arrow, and to jump all 
the way to the end, click the double-right arrow.  Clicking on the time series plot 
jumps to that time step in the animation. 
 

 
Figure 4: The Results Animation tab shows the full time-dependant model output. 

The depth and wave amplitude at the time series location are displayed at the 
top, and is a good way to determine wave amplitude at a given location and time 
step. 
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Velocity vectors can be seen by clicking on the Show Vectors button.  The length 
of  the vector is proportional to the velocity at the vector’s position, and the scale 
is shown at the top next to the “Show Vectors” button.  This can be scaled up and 
down to best show the current velocities in the plot.  Pressing the animation 
button allows the vectors to animate along with the wave amplitude field. 
 

 
Figure 5: Wave Amplitude with velocity vectors 

Zooming the Wave Amplitude plot can be done by clicking and dragging in the 
plot, and right-clicking gives a menu that allows the user to Reset Zoom (zoom all 
the way out).  The user can also select a pseudo-log scale color map (useful for 
very small amplitude tsunami simulations), and the plot can be saved as an 
image.  
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Results Extrema tab 
 
The Results Extrema tab shows the model results as either the Maximum Wave 
Amplitude over time, the Flow Depth, the Minimum Wave Amplitude, or the 
Maximum Wave Speed (Figure 6).  The user can choose the preferred view by 
selecting “Max Amp”, “Flow Depth”, “Min Amp” or “Max Speed”, respectively.  By 
moving the mouse over the plot, the Longitude, Latitude, Depth, and Amplitude 
are output at the top, and the Show Vectors shows the velocity vectors as in the 
Results Animation tab (previous section).  Note that the velocity vectors 
represent the speed of the maximum current and the direction of the current at 
the time of its maximum. 
 

 
Figure 6: Maximum wave amplitude shown in the A-grid for the crescent Model Run. 
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ComMIT Menu items 
 
The desktop version of ComMIT currently supports running one Model Run at a 
time, so the “Model” menu items typically apply to the Model Run that is loaded 
and showing in the pull-down Model Run selector at the top of ComMIT.  A Model 
Run consists of the 3 bathymetry grids (A-grid, B-grid and C-grid) and the MOST 
model parameters file.  These four items are in a folder named with the Model 
Run name, hence a Model Run is a folder that can be opened by clicking on the 
Model Run button in the Model Setup tab. 
 

The Model Menu item 
 
The Model menu item allows the user to Open and Close a Model Run.  Results 
are saved even when a Model Run is closed.  Model Run results are only cleared 
when 
 

 
Figure 7: The Model menu item. 
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the user chooses new Sources, or when the user chooses the “Clear Model 
Results” menu item (Figure 7).  A “New Model Run” can be created by selecting 
this option.  A dialog helps the user identify three bathymetry grids by either 
opening files the user supplies or requesting files from the ComMIT Server.  
More details on this can be found in the following section. 
 
Deleting a Model Run requires the user to be cautious because it is the only 
function that actually deletes bathymetry files.  The user is given a warning about 
this, but it is wise to keep in mind that model results are easy to create, while 
bathymetry is not!  The “Delete Model Run” menu item deletes the entire Model 
Run folder: model results, grid files, and MOST parameter file.  The “Clear Model 
Results” menu item only clears the model results, which can, of course, be re-
created by simply pressing “Start model” and re-running. 
 
The “Import Model Run” and “Export Model Run” simply creates a zip file of the 
Model Run folder with just the bathymetry and model parameter files.  This 
makes it easy to attach to an email if the user would like help from the modeling 
Community. 
 
The next group of Model menu items 
simply allow the user to Save the results 
in different file formats.  The Animation 
Frames saves each frame of the Results 
Animation as a sequence of numbered 
image files in PNG format for creating a 
movie (the user is tasked with combining 
these files into an animation).  The “Save 
Time Series as ASCII” saves the time 
series in the Results Animation tab to a 
file.  The “Save as Google Earth file” does 
just that, with options to save just 
maximums or an animation.  If a specific 
tsunami event is chosen to model, times in 
the Google Earth file are UTC. 
 
The Create Composite Wave File option is 
described in the next section. 
 

Create Composite Wave File 
 
A common use of ComMIT is to create a hazard assessment or evacuation map 
for a given location.  The technique is covered in the ComMIT training workshops 
and involves running the same Model Run bathymetry using many different Unit 
Source combinations.  If the user saves all the Model Runs for a hazard 
assessment, a composite maximum wave amplitude file can be created with this 
menu item.  The users is given a list of Model Runs in their ComMIT folder and 



 16 

asked which should be included in the composite (Figure 8).  Since all the Model 
Runs must use the same bathymetry in a hazard assessment, using the “Copy 
Model Run” feature simplifies this task. 
 

 
Figure 8: Creating a Composite Wave File.  Three Model Runs have been selected by the user. 

 
 

Tsunami Events and Tweb 
 
The last set of menu items have to deal with 
getting Unit Sources appropriate for 
historical tsunami events.  The “Add Event” 
feature opens a dialog showing event 
information from the archives of real tsunami 
events.  The archives are only a subset of all 
tsunami events, but each event for which a 
Unit Source solution has been obtained 
through the NOAA tsunami forecast system 
is listed.  The information shown includes 
the date and time (in UTC), the moment 
magnitude (Mw), the epicenter location 
(degrees latitude and longitude), and a short 
descriptor identifying the event. 
 
 
The  dialog allows the user to choose the event from the list of events, giving 
ComMIT the “authoritative” Unit Sources for the event (Figure 9).  As a new 
event occurs, this authoritative solution is updated as more data comes in from 
the DART buoy array and new inversions are performed.  
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Figure 9: List of tsunami events in the "Add Event" dialog 

 When a user selects a given event, the Model Run will update the Unit Sources 
selected in the map on the Model Setup tab, and shows the “Event: …“ 
information: 
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The other change is that on the Results Animation tab, if there is a tide gauge in 

the C-grid, it will be shown as an inverted black triangle ( ) and the tide gauge 
data for the time period for the event will be plotted in the time series window with 
the gauge data in black and the model output in red (Figure 10).  The user can 
double-click on the wave amplitude plot to set the time series location (green 
star) near the black triangle representing the gauge position to compare the 
model results to the tide gauge results.  Keep in mind that the gauge locations 
reported in the IOC tide gauge web service that ComMIT relies upon are often in 
error, sometimes by as much as a kilometer or more!  Looking at Google Earth or 
other aerial photography source usually allows the user to identify which pier the 
tide gauge is deployed on. 
 

 
Figure 10: Tide gauge comparison at Crescent City for the Tohoku, Japan tsunami of 11 March 2011 

 
Removing an event from a Model Run simply removes the tide gauge data, and 
the Event label from the Model Setup tab. 
 
For users with Tweb accounts with “forecaster” status, Publish Model Run allows 
uploading the model results for a given event to Tweb, the on-line interface to the 
operational tsunami forecast system, SIFT (Short-term Inundation Forecasting for 
Tsunamis). 
 
The “Sources from Solution/Combination” allows selecting Unit Sources by 
entering the Alphas and Unit Source names manually.  This is helpful when 
obtaining a solution via email, or copy-and-paste from another application, such 
as Tweb. 
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Custom Propagation Run 

 
The Custom Propagation Run menu item allows the user to add custom seismic 
Propagation Database files to ComMIT using the MOST model, defining the 
seismic parameters of an earthquake using the standard for fault plane 
description as described in the MOST manual (e.g., specifying epicenter, length, 
width, depth, slip, dip rake and strike).  Selecting this item opens a new window 
for the creation of this new propagation run: 
 

 
Figure 11: The Custom Propagation window showing maximum wave amplitude as the model runs. 

This interface is very similar to the main ComMIT window, in that the propagation 
model is run with a “Start Propagation” button at the top, with a progress bar 
showing model progress, and output is animated with the animate buttons or 
wave maximum amplitude is shown.  Full propagation runs can take several 
hours to run as the grid sizes are considerable.  The parameter selection at the 
top allows the user to set Seismic Info, Source Identification information, or 
Model Parameters.  
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Seismic Info 
 
The seismic information is entered at the top left by selecting a bathymetry file 
(defaults to a Pacific Ocean basin bathymetry), and entering the basic fault plane 
parameters.  The user may double-click on the map to set the epicenter latitude 
and longitude, as indicated by the yellow star with fault plane outline.  When the 
user changes parameters, the fault plane outline adjusts according to the 
geometry requested: 
 

 
Figure 12: Configuring a custom Propagation run with a source name of cu2a and 12 meter slip. 

Source Identification 
 
The source is given an identification to fit the NOAA Propagation Database 
naming convention, using the “cu” identifier to mark it as “custom”.  The row 
number and column letter can be incremented, and many custom runs can be 
added and selected in the drop-down selector marked “cu2a” in Figure 12. 
 

Animation 
 
The animation buttons work just as in the main “inundation” window in ComMIT, 
allowing the user to “play” the animation by clicking the right-facing triangle 
button, to single-step through the animation, or, by using the slider bar below the 
animation buttons, to select a given time step.  Selecting the “Max Amp” button 
disables the animation and instead shows the wave maximum amplitude over 
time as in Figure 11.  
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Model Parameters 
 
The model parameters are exactly analogous to the main ComMIT inundation 
model parameters, with the exception that there are no inundation algorithm 
settings.  See the Set Model Run Parameters section for a description. 
 

Using Custom Sources 
 
The resulting sources are automatically added to the Propagation Database in 
the main ComMIT window, under the Model Setup tab.  Notice in this case that 
the user has chosen an epicenter well offshore of the normal Unit Sources.  
Using this source is as easy as clicking on it, choosing a Model Run location (e.g. 
“crescent” for Crescent City), and clicking “Start model”. 
 

 
 
In this example, the inundation due to a custom source “cu2a” offshore of the 
Kuril island chain is seen in the maximum amplitude plot for Crescent City: 
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The Edit Menu item 
 
The Edit Menu item allows the user to edit either ComMIT preferences or the 
Bathymetry files.  The ComMIT preferences consist of setting the directories 
(folders) where ComMIT files are, including default locations for bathymetry grid 
files (Grids Directory), the directory Model Runs are in (Scratch Directory), the 
MOST model executable (usually downloaded from the ComMIT Server), and the 
ComMIT Server itself (Figure 13).  The Unit Sources in ComMIT are provided 
through the ComMIT Server, but the Propagation Database tab allows adding a 
local repository of propagation model results to use as sources.  The Network tab 
allows setting proxy information if you are running ComMIT behind a proxy 
firewall. 
 

 
Figure 13: The ComMIT Preferences dialog. 

 
 
 
 
 

The View Menu item 
 
The View menu item allows the user to see information about the bathymetry 
grids, or to see the extents of the Unit Source propagation files (grouped into 
Pacific, Indian and Atlantic Ocean basins).  
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The View Grid Information (CFL) menu item shows a dialog of statistics about 
each of the three bathymetric grids for the open Model Run (Figure 14).  The 
information includes filename, dimensions, extents (in latitude and longtidue), the 
resolution or “spacing”, the maximum height and depth, and the CFL criterion for 
each grid. 
 

 
Figure 14: The Edit -> View Grid information (CFL) dialog for Crescent City. 
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Creating New Model Runs 
 

Global bathymetry data 
 
New Model Runs are created by using the Model -> New Model Run menu item.  
Users can use this feature to either load their own bathymetry grids, or download 
bathymetry grids from the ComMITServer. 
 
The ComMITServer provides combined bathymetric/topographic gridded digital 
elevation models for tsunami modeling.  
 
While the dataset is useful for training and demonstration purposes, it was 
automatically generated primarily from low-resolution bathymetric data sources, 
and has received limited manual review. It should not be used for hazard 
mapping or similar purposes. 
 
The ComMITServer bathymetry dataset is derived from two sources: 
 

• Bathymetry is from the ETOPO1 1 arc-minute gridded global relief model 
produced by the NOAA National Geophysical Data Center. The ETOPO1 
dataset is compiled from many different global and regional data sets, 
evaluated and edited, and shifted to reference mean sea level vertically, 
and WGS84 horizontally. This data has been INTERPOLATED FROM 60 
ARC-SECONDS TO 3 ARC-SECONDS to match the topography data set. 
This makes it inappropriate for any use except training. 

• Topography is from the CGIAR SRTM 90m version 4 digital elevation 
model produced by the CGIAR Consortium for Spatial Information. This 3 
arc-second (~90 meters at the equator) dataset is a processed version of 
the Shuttle Radar Topography Mission (SRTM) data created by NASA.  

 
The Etopo1 data was interpolated from 60 arc-seconds onto the 3 arc-second 
SRTM grid after setting Etopo1 land values to -1.5 meters. Land values are then 
replaced with the SRTM data. This interpolation produces a dataset is relatively 
inaccurate in bathymetry, but tends to be stable for most sources using the 
NCTR propagation database, and is therefore useful for training purposes. NCTR 
recommends it be used only for this purpose.  
 
 
 

Using the New Model Run Wizard 
 
To use this data, user clicks on the Model -> New Model Run menu item.  This 
opens a Wizard that helps the user select (or request) bathymetry grids, and 
creates a default Model Parameters file.  The Wizard walks the user through a 
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series of steps, the first of which simply asks the user to name the Model Run 
and click “Next”: 
 

 
 
In steps 2-4, the user selects the three bathymetric grids.  The user can either 
browse to a grid file by clicking the “Browse” button, or zoom the map to a region 
and “rubber-band” an extent by holding down the shift button and dragging the 
mouse: 
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After a region is selected by holding the shift key and dragging the mouse, the 
Grid Extents are shown, and a grey rectangle of the region is plotted.  For the A-
grid, the region should be at least as large as the 5 degree by 5 degree black 
squares on the plot.  The default cell size is 120 arc seconds.  In this case the 
dimensions of the A-grid will be 174 by 161.  There is a limit on the size of the 
grid requested from the ComMIT Server of 160,000 points (e.g., 400 by 400).  
The Wizard does not allow requesting files larger than this. 
 
After selecting the region, the user can click “Next” and select the B-grid and C-
grid in the same way.  As the resolution of the background map is fairly crude, it 
often helps to have a reference map, such as Google Earth, open to pinpoint the 
C-grid area of interest.  It is helpful to “rubber-band” a region, and then edit the 
Grid Extents manually to get exactly the extents you want: 
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Adjusted manually to the exact extents to lower the total number of points: 
 

 
 
 
The last step requires the user to click “Finish” to send the request to the 
ComMIT Server.  Requesting bathymetry grids can take a while: ComMIT gives a 
progress bar in the lower left part of the Wizard while it downloads grids.  When it 
is done, the user clicks “Close” to close the Wizard, and the new Model Run is 
loaded: 
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The user can view the grid files under the Grid Bathymetry tab: 
 

 
 
And run the model to see inundation results: 
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Note that bathymetry grids from the ComMITServer are saved under the 
ComMIT/grids folder, and then copied to the Model Run folder.  If a user-supplied 
grid is used (by clicking Browse in the Wizard), it, too, is copied to the Model Run 
folder so as to preserve the original file.  Bathymetry cropping and smoothing 
only affect the version in the Model Run folder, not the original file. 
 
 

More Information 
 
For more information about ComMIT, tsunami forecasting, and hazard 
assessment, please visit the NOAA Center for Tsunami Research at: 
 
http://nctr.pmel.noaa.gov 
 
 


